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ETABS® Version 18.1.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2019 

Notice Date: 2019-12-10 
 
 
This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 
Items marked with an asterisk (*) in the first column of the tables below are more significant.  
 
The reference number for each change below is now the development Ticket rather than support Incident which was 
used in earlier Release Notes. Emails sent when an Incident is released will now indicate this Ticket number as well. 
 

Changes from v18.0.2 (Released 2019-09-03) 

Installation and Licensing 
Enhancements Implemented 

* Ticket # Description 
  2776 The version number has been changed to v18.1.0 for a new intermediate release. 

Structural Model 
Enhancements Implemented 

* Ticket # Description 
  2211 An incident was resolved where the CISC10 frame-section database contained certain sections 

that are not listed in the CISC Handbook Tenth Edition. These sections were identified and 
removed from the CISC10 section database: W200x21, W250x24, W310x31, W460x61, 
W460x67, W530x72, W530x82, WT265x41. Additionally, auto-select lists similar to those 
already available in the CISC9 frame-section database have been added to the CISC10 section 
database.  

* 2918 An enhancement has been made to allow the assignment of acceptance criteria to piers and 
spandrels that measure forces, stresses, or stresses as a ratio of the square-root of the 
concrete compressive strength f'c. The acceptance criteria can be assigned individually to each 
pier and spandrel label on each story by selecting any object that is assigned to the 
pier/spandrel label and using the commands Assign > Assign Pier Force Acceptance Criteria 
and Assign > Assign Spandrel Force Acceptance Criteria. Pier-force acceptance criteria can be 
defined for V2 or V3 shear and may depend on the axial force/stress of the pier. Spandrel 
force acceptance criteria can be defined for V2 shear. The pier/spandrel force status ("A to 
IO", "IO to LS", "LS to CP", and "> CP") are output in the Database tables under Analysis 
Results > Element Output > Wall Output. 

* 2919 An enhancement has been made to allow the assignment of acceptance criteria to Link and 
Panel Zone properties. For Link properties, the acceptance criteria can be defined as either 
displacement or force for any degrees of freedom that are active and not fixed. For Panel Zone 
properties, the acceptance criteria can be defined as moment or rotation. The Link and Panel 
Zone status ("A to IO", "IO to LS", "LS to CP", and ">CP") are output in the Database tables 
under Analysis Results > Element Output > Link Output for Links and Analysis Results > 
Element Output > Panel Zone Output for Panel Zones.  

* 3364 As an enhancement, a built-in material library for the Korean region has been added. The 
library contains steel, concrete, and rebar materials per the KBC 2016 standard. 
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Analysis 
Enhancements Implemented 

* Ticket # Description 
* 2701 A new feature is available for running multiple load cases on separate parallel processors, 

significantly speeding up models with many independent load cases. This can be particularly 
useful where a large suite of earthquakes needs to be considered, such as for performance-
based design. This option is turned off by default, since it can affect the performance on 
machines used for multiple purposes. When enabled, the number of processors to be utilized 
can be set explicitly or can be determined automatically as the number of physical processors 
found on the machine. Sequential load cases will be run on a single processor. Parallel load 
cases will be automatically assigned to processors as they become available, after any 
prerequisite load cases have been run. This feature requires sufficient memory (RAM) to 
support the number of parallel instances of the analysis engine. Larger models may run faster 
with fewer processors if memory is limited. All processors will access the disk, which can 
become the limiting factor for speed if the disk is slow or if the number of processors utilized 
becomes too large. 

* 3098 An enhancement has been implemented to more clearly display and save messages generated 
during analysis runs. These are the same messages that appear in the analysis LOG file but 
provided in a more concise format. Analysis messages are categorized as information, 
warnings, and errors. After the analysis is run, messages are automatically displayed as text if 
there are any warnings or errors in the latest run. This same text display is available any time 
using the command Analysis > Messages. The messages are also available in tabular format 
under table Analysis Results > Run Information > Analysis Messages. Messages are cumulative 
with subsequent runs until the model is unlocked, at which time the messages are deleted. 
Each message includes its type, message text, associated load case or stiffness case, operation 
being performed, date-time stamp, parallel run tag, run serial number, and machine name. 
The run serial number counts subsequent runs before the model is unlocked. The parallel run 
tag indicates which thread was used when analyses are run in parallel during the same 
analysis run. 

Design – Concrete Frame 
Enhancements Implemented 

* Ticket # Description 
  2998 An enhancement has been made to concrete frame design per the Russian code SP 

63.13330.2012 to allow an additional input parameter for the reliability factor, Gamma_n, in 
the Design Preferences. The reliability factor is used to obtain the design seismic force 
depending on the functional use of the structure. It is considered the level of responsibility for 
the structure. For essential structures, it is more than 1.0, for temporary structures it may be 
less than 1.0. Its default value is taken as 1.0. However, the user can change it to any positive 
value. By increasing the reliability safety factor Gamma_n, the design force values are 
practically increased by multiplying by that factor. 

  3059 An enhancement has been made for concrete column design to report in the detailed output 
the forces corresponding to the worst D/C ratio from the many force sets that are used to 
design for a given loading combination. Previously, this was not happening when the 
minimum rebar governed for all of the force sets. In such a case the first set was stored and 
displayed regardless of which force set had the worst D/C ratio. By way of background, 
multiple force sets are considered in a load combination for design whenever the combination 
is multi-stepped or is an envelope requiring permutations of axial load, minor and major 
moments. No design results are affected.  
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Design – Steel Frame 
Enhancements Implemented 

* Ticket # Description 
* 2147 An incident was resolved for steel frame design per the Russian code "SP16.13330" that 

corrected or improved several issues. Some of these changes were mandated updating the 
code from 2011 to 2017. Other changes were corrections or updated interpretations of code 
clauses that did not change between versions: 
(1.) The parameter I_t is now taken as the sum of(K/3)*b*t^3, where K = 1.29 for doubly-
symmetric I-sections, 1.25 for singly-symmetric I-sections, 1.12 for channel-sections, 1.2 for T-
sections, and 1.2 for double-angle sections, all based on the 2017 specification 
SP16.13330.2017 Annex G. Previously the value of I_t was taken from values specified in the 
frame-section database. This parameter affects the calculation of phi_b and c_max. 
(2.) The expression for phi for doubly-symmetric sections (such as standard I sections and 
double-channel sections) is calculated differently from singly-symmetric sections (such as 
singly-symmetric I-sections, double-angle sections, and T-sections). Previously the value of psi 
was always calculated following the case of doubly-symmetric section per SP 16.13330.2011 
Table G.1 and Table G.2. For the singly-symmetric section, the parameter psi (or psi_a) is now 
calculated based on SP16.13330.2011 G.4 Eq. (G.9), section G.4, section G.5, Table G.4, and 
Table G.5. All conditions of G.6 and G.7 are used. If the parameter n is larger than 0.9 (0.9 < n 
< 1.0), interpolation is used for the value of n between those for pure T-sections and singly-
symmetric I-sections to determine the value of psi. The parameter psi is used to calculate 
phi_b. The detailed design report now provides more information on the calculation of these 
values. 
(3.) The following changes apply for the calculation of Cmax: 
(3.a) The parameter h is taken as the distance between the two centers-of-gravity of the top 
and bottom flanges for I-sections, channel sections, and double-channel sections. It is taken 
from the bottom of T-sections and double-angle sections to the center-of-gravity of the top 
flange following the 2017 specification SP 16.13330.2017 Annex E. Previously it was taken as 
the clear distance to the flanges for I-sections, channel sections, and double-channel sections; 
and from the bottom of T-sections and double-angle sections to the bottom of the top flange. 
(3.b) The parameter n is taken as n = I1 / (I1 +I2) where I1 and I2 are the moments of inertia of 
the major and minor flanges about the section minor axis per SP 16.13330.2017 Annex Eq G.8. 
Previously the expression n = Iy / (I1 + I2) was used following the code, which was incorrect. 
The parameter n for double-angle sections and T-sections is now taken as 1. 
(3.c) The parameters omega, alpha, and mue are now calculated differently for the major and 
minor bending axes of channel sections based on the specification SP 16.13330.2017 Annex E 
and Annex G. Previously the expressions for omega, alpha, and mue did not differ for the 
major and minor bending axes of channel sections. 
(3.d) The case of channel section with Imajor > Iminor has been added in the implementation 
per the Annex E.6 for cmax calculation. 
(4.) If the shear-stress ratios (tau/Rs) for both the major and minor directions are small (less 
than 0.01, essentially pure shear), then cm for the major and minor directions is calculated 
based on equation SP16.13330.2011 8.2.3, Eq. (53). Otherwise, cm is taken as c. Previously 
these same equations were used, but the limiting condition used was different. It used to be 
applied for singly-symmetric beams. 
(5.) The parameter c is now only calculated for singly-symmetric I sections, doubly-symmetric I 
sections, double-channel sections, channel sections, double angle sections, and T-sections per 
SP16.13330.2011 9.2.5, Table 21. For all other sections, it is taken as 1.0. Previously it was 
calculated for all section types using the same expressions that are applied for the listed 
flanged sections. 
(6.)  When the section width-to-depth ratio is less than 0.3 (b/h < 0.3), the c factor 
(SP16.13330.2017 9.2.5) is now taken equal to 0.3. 
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* Ticket # Description 
(7.) For I-shaped sections buckling in the minor direction, the column curve used has been 
changed. For major-axis bending, the column curve “a” is used for rolled sections with a 
section depth larger than 500m, and the column curve “b” is used for all other cases. 
However, the column curve “c” is now used for minor-axis bending per the new 2017 
specification SP 16.13330.2017 7.1.3, Table 7. Previously the column curve “b” was used for 
minor-axis bending. For singly-symmetric I-sections, the column curve “c” is now used both 
major and minor directions. 
(8.) When lambda_bar < 0.6, the ϕ buckling factor is now taken as 1.0 for buckling curves "a" 
and "b" (SP 16.13330.2017 7.1.3). 
(9.) For singly-symmetric sections, the interaction ratios calculated for Eq. 105 and Eq. 106 of 
SP 16.13330.2011 section 9.1.1 now consider different compression-side or tension-side 
section moduli, as appropriate. Previously the minimum section modulus was always used, 
which could have been over-conservative. 
(10.) The interaction equations Eq. 41 and Eq. 43 of SP 16.13330.2011 section 8.2.1are now 
only checked if the axial force in the member is small, specifically if N < (0.1 * Ry * A).  
Previously these equations were checked regardless of the axial force, and the design could be 
over-conservative for larger axial force. 
(11.) When simply-supported beams are checked against shear at the support stations, flanges 
are now ignored in Eq. 42 used for shear strength calculation. Therefore, the static moment of 
area is now calculated using only the web. For example, for the middle point of the I-section 
of depth h and web thickness tw, the static moment is calculated as follows: S = (h/2 * tw) * 
h/4. 

* 2235 An enhancement has been made to update the Russian steel frame design code to 
SP16.13330.2017 from the previous SP16.13330.2011 version. 

  2787 An enhancement has been made to the steel frame design code "Chinese 2018" in which the 
factor gama_RE(S) is now taken as 0.8 when the beam is designated as a Flexo-Compression 
member. It is taken as 1.0 when the beam is not designated as a Flexo-Compression member. 
Previously its default value was 1.0 irrespective of whether the beam’s designation was a 
Flexo-Compression member or not. 

 2999 An enhancement was made to concrete frame design per the Russian code SP 63.13330.2012 
to allow two additional input parameters for seismic factor in the Design Preferences: 
m_tr,flexure and m_tr,shear. The parameter m_tr,flexure is applied to enhance the steel and 
concrete design strengths Rb and Rs when the design load combination contains an 
earthquake load case.  It is typically equal to 1.2 per Table 6 of SP 14.13330.2014 and used for 
column NMM (PMM) design, beam flexure design, and beam torsion design.  The parameter 
m_tr,shear is also applied to enhance the steel and concrete design strengths Rb and Rs when 
the design load combination contains an earthquake load case.  It is typically equal to 1.0 per 
Table 6 of SP 14.13330.2014 and used for column shear design and beam shear design.  In 
addition, the values of the relative neutral axis depth, XiR, is reduced for beams by a reduction 
factor based on seismicity when a seismic load is present in the load combination. The 
reduction factor is equal to 0.85 for Seismic Intensity 7, 0.7 for Seismic Intensity 8, and 0.5 for 
Seismic Intensity 9. However, this reduction is not performed when the structure is declared 
Non-Seismic, even if the load combination is seismic. 

Design – Shear Wall 
Enhancements Implemented 

* Ticket # Description 
  2850 An enhancement was added for AS3600-2009 shear wall design where boundary zone design 

is now performed when compressive stress in extreme fiber exceeds the limit of 0.15f'c. 
Previously this limit was 0.2f'c. 
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Results Output and Display 
Enhancements Implemented 

* Ticket # Description 
  502 An enhancement has been made to output nonlinear energy components (nonlinear 

hysteretic damping and nonlinear viscous damping) per group for nonlinear load cases. The 
nonlinear energy is reported separately for model objects (internal element energy) and 
support elements (support element energy). The energy output is available in the "Element 
Nonlinear Energy By Group" table and "Energy by Group" type function in using the Display > 
Plot Functions command.  

* 2047 The Performance Check feature (Define menu > Performance Check) has been enhanced to 
provide greater control over the calculation and tabular output of the demand-over-capacity 
ratio (D/C ratio) for the performance check of the whole model, as well as for each object 
individually. The performance-check feature is available for nonlinear static and nonlinear 
time-history load cases. A performance check can now include acceptance criteria from links, 
strain gauges, pier and spandrel forces, and panel zones, along with frame and wall hinges 
which were previously available. Multiple demand sets can be specified in a performance 
check definition, allowing more control over the performance check results. To calculate the 
D/C ratio for an object, the demand from each load case present in a demand set will be 
combined using the specified combination method (Maximum, Mean, SRSS, or Absolute Add). 
The combined D/C ratio for each demand set in the performance check will be combined using 
either Maximum or using Mean plus a multiplier times standard deviation. Tabular results are 
available under Analysis Results > Structure Output > Performance Check Output. 
Performance check results can be displayed graphically using the command Display > 
Performance Check. 

* 3060 Two new plot items have been added for displaying results: 
(1.) A new plot function "Acceptance Criteria D/C Ratio" has been added. This plot function 
can be used to display the demand-over-capacity ratio (D/C ratio) for a specified group and 
specified performance level for all steps of a multi-stepped load case (e.g. time-history).  
(2.) A new menu item (Display > Performance Check Usage Ratio Diagram) which shows the 
demand-over-capacity ratio (D/C ratio) for all demand sets in a performance check and for a 
specified performance objective. This display is a visualization tool to show the relative 
contribution of each demand set and/or object type in a performance check.  

User Interface 
Enhancements Implemented 

* Ticket # Description 
  2650 The order of load cases shown in drop down lists for definition forms as well as for results-

display forms have been made consistent and are listed in the order the load cases are 
defined. The order of load combinations shown in drop down lists for definition forms as well 
as for results-display forms have been made consistent, and are now listed alphabetically. This 
enhancement was implemented for previously released ETABS v18.0.2 but was inadvertently 
omitted from the Release Notes. 

Graphics 
Enhancements Implemented 

* Ticket # Description 
  2774 A new option is available to set the color of strain gauges on the "Set Display Colors" form. 
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Database Tables 
Enhancements Implemented 

* Ticket # Description 
  2836 An enhancement was made to add new capability to perform filters and sorts in displayed 

database tables by right-clicking in the table column headers. These new capabilities work 
with a single column at a time. Advanced filtering and sorting are still available using the 
Format-Filter-Sort menu in the table display form. 
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Structural Model 
Incidents Resolved 

* Ticket # Description 
  2676 An incident was resolved where Check Model operation sometimes generated incorrect "too 

close" messages for shells that were not actually overlapping. This did not affect analysis 
results. 

* 2959 The self-weight calculation for layered shell sections has been changed. Previously, a layer 
contributed to the self-weight of the section if the modeling type was "Shell" or "Membrane" 
and either S11 or S22 was active. This behavior has been changed such that a layer contributes 
to the self-weight of the section if the modeling type is "Shell" or "Membrane" and any of the 
directions (S11, S22, or S12) is active. This change only affects the self-weight of layered shell 
sections that have a layer with only S12 enabled. If the user wants this layer not to contribute 
to self-weight, then it should be assigned a material property with a weight density of zero. 
Note that this change only affects self-weight; self-mass was already being considered for all 
"Shell" and "Membrane" sections. Now self-weight and self-mass are consistent. 

  3021 An incident was resolved where specified boundary zones lengths in the Wall Hinge 
Reinforcement form were not being converted correctly to the database units. This could 
cause the values to be saved incorrectly, or it could generate error messages when changing 
values in the form. Note that database units are those set when the model is first created or 
imported. Typically, the length database units are mm or inch when a model is created, and 
the error would likely occur if different units were used to define the length of the Start Zone 
or End Zone. 

Section Designer 
Incidents Resolved 

* Ticket # Description 
  2900 An incident was resolved where trying to display moment-curvature relationship of a concrete 

section in Section Designer would result in an error condition if the Young's Modulus of 
concrete was artificially set too low relative to its value based on the concrete strength 
specified. This condition is now trapped. 

Loading 
Incidents Resolved 

* Ticket # Description 
  3339 An incident was resolved for the NBCC 2015 auto seismic load case for shear wall building 

systems where the minimum base shear was incorrect. Minor changes have also been made 
to the auto seismic report that do not affect results. 

Analysis 
Incidents Resolved 

* Ticket # Description 
  2670 An incident was resolved where an error message was generated when trying to run a 

second analysis immediately after running the analysis for the first time with the model 
unlocked and "Calculate Diaphragm Centers of Rigidity" option selected. When this occurred, 
the second analysis did not run, and results were not available for the load cases selected to 
run. Subsequent attempts at running the analysis did not generate further errors. 
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* Ticket # Description 
* 2852 An incident was resolved where changing parameters for a Response Spectrum Load Case 

may not reflect in the torsional response if the change to the case was made with the model 
locked. The additional associated torsional loads due to accidental torsion were not getting 
properly updated. The translational lateral loads were updated, but the old torsional loads 
were still being used. Re-running the load case after unlocking the model would correct the 
problem. Now the torsional loads are being updated even if the model is locked. 

  3323 An incident was resolved where a modal time-history load case would not start during an 
analysis if it used the modes from a modal case having a nonzero frequency shift that was run 
at the same time. The modal time-history load case would complete during a subsequent 
analysis if the prerequisite modal case had been run in a previous analysis. This was an 
inconvenience only. No results were affected. This incident was resolved in version v18.0.0 
but inadvertently omitted from the Release Notes. 

  3324 An incident was resolved where the nonlinear behavior of a Directional-type layer of a 
layered shell defined with a material property that has a non-zero friction angle did not 
behave as documented in the Analysis Reference Manual. The behavior is now changed so 
that the friction behavior uses the average of the axial force in the S11 and S22 directions of 
the layer, if both directions are active; this is suitable for materials like sand where there is no 
distinct slip plane. If only one direction is active in the layer, the axial force of the active 
direction is used for computing the friction behavior; this is suitable for the case where the 
slip plane is perpendicular to the axial load. The shear-friction behavior is modeled as a Wen 
hysteresis model where the force-deformation relationship is smooth between the initial 
shear stiffness and sliding behavior. This change does not affect the behavior of Directional 
shell layers defined using a material property that has a zero friction angle, which is the 
default for all materials. Likewise, the behavior of Coupled layers is not affected. This Incident 
was resolved for previously released ETABS v18.0.2 but was inadvertently omitted from the 
Release Notes. 

  3325 An incident was resolved where a model with many parametric PMM hinges running multiple 
time history load cases may cause the ETABS analysis process to consume a large amount of 
memory or, in some cases, to terminate with an "Out of Memory" error. This issue could be 
mitigated by manually running the load cases in several batches with the Analysis Process 
Options set to "Separate Process". The accuracy of results obtained from analysis were not 
affected. This Incident was resolved for previously released ETABS v18.0.0 but was 
inadvertently omitted from the Release Notes. 

  3326 An incident was resolved where an error message would be generated at the start of analysis 
for models containing a layered shell property having a layer with "Coupled" behavior and 
using a concrete material property where the last point of the stress-strain curve on the 
compression side had zero stress. This would occur because the Darwin-Pecknold model used 
for coupled concrete behavior requires non-zero stress values for the compressive material 
behavior. When this error occurred, no analysis results were available. The behavior has been 
changed so that all compressive stress values in the stress-strain curve that are smaller in 
magnitude than 0.0001 times the peak compressive stress will be set to that small limiting 
value. This change only affects the behavior of the material when used in a Darwin-Pecknold 
model for "Coupled" shell layers. This Incident was resolved for previously released ETABS 
v18.0.2 but was inadvertently omitted from the Release Notes. 

* 3327 An incident was resolved where an abnormal termination error occurred when a nonlinear 
direct integration time history case with ground displacement loading was run separately 
from the nonlinear case it was continuing from. The results for the nonlinear direct 
integration time history case were not available. This Incident was resolved for previously 
released ETABS v18.0.2 but was inadvertently omitted from the Release Notes. 



ETABS v18.1.0 ISO# RELETA1810          2019-12-10 Page 9 of 16 

* Ticket # Description 
* 3328 An incident was resolved where the analysis could terminate with a fatal error when a 

staged-construction load case was run that contained the operation Change Section on link 
objects, and was then followed in the same run by a nonlinear static, direct-integration time-
history, or another staged-construction load case that continued from the same previous 
stiffness case as the stage-construction case with the Change Section operation. For example, 
consider initial case LC0 followed by staged-construction case SC1 and separately by 
nonlinear static case LC1. If case SC1 changes link sections, then case LC1 may fail if it runs 
after SC1. This error did not occur if LC1 was run in a separate instance from SC1. This error 
did not occur when the link section properties were of the same type and size (number of 
data points for multi-linear properties) before and after the section change operation. When 
this error occurred, analysis results were lost. Otherwise, results were not affected. This 
Incident was resolved for previously released ETABS v18.0.0 but was inadvertently omitted 
from the Release Notes. 

Design – Concrete Frame 
Incidents Resolved 

* Ticket # Description 
  2756 An incident was resolved for concrete frame design per the IS 456:2000 code where the Q 

factors were not being updated when lateral load cases were updated or deleted without 
unlocking the model. Rerunning the load cases after unlocking the model would update the Q 
factors. 

  2868 An incident was resolved for the concrete frame design code "ACI 318-14" where the torsion 
design of concrete beams could be under-reinforced when Tu fell between the threshold limit 
and the cracking value (Tth< Tu < Tcr). In this case the required torsion rebar (At/s and Al) was 
not calculated per section22.7.6.1 and only the minimum rebar was being provided per 
section 9.6.4.2. The calculation of rebar areas At/s and Al was correct for Tu< Tth and for Tu > 
Tcr. 

 

Design – Steel Frame 
Incidents Resolved 

* Ticket # Description 
  2788 An incident has been resolved for the steel frame design code "Chinese 2018" where the 

phi_b factors were not exactly correct for members that had a linear moment diagram. The 
beta_b factors were not being overwritten correctly by the equation given in Item 10 of 
GB50017-2017, App C, Table C.0.1.  

  2943 An incident was resolved in the Canadian steel frame design code CSA S16-14 where the 
section classification for tee, angle, and double-angle sections had an error in the 
determination of the slenderness for the stem (tee) and the vertical leg (angle and double-
angle). Previously the flange or horizontal leg b/t ratio was being used while checking for the 
stem or vertical leg slenderness of these sections. Note that the stem or vertical leg is parallel 
to the local-2 axis of the section. 

  3337 An incident has been resolved in the New Zealand steel frame design code "NZS 3404:1997" in 
which the value of slenderness Lambda_e for flanges was conservatively taken based on the 
full width rather than clear width. For example, for I-shaped sections, the b/t for flange was 
being taken as (bf/2)/tf instead of (bf-tw)/(2*tf). Similarly, the b/t for webs are also 
considered. The result was slightly conservative. 
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Design – Shear Wall 
Incidents Resolved 

* Ticket # Description 
  2351 An incident was resolved for shear wall design per the ACI 318-14, ACI 318-11 and ACI 318-08 

codes where ACI Equation 11-28 was not properly disregarded when term (Mu/Vu – lw /2) 
was negative. This was limiting the shear capacity to 0.6λ fc′ instead of using ACI equation 11-
27. Results were always conservative. 

  2680 An incident was resolved for shear wall design of piers where, for certain sections, the pier 
was broken into more legs than necessary. This happened when area objects comprising a co-
linear leg were drawn out of sequence. 

  2851 An incident was resolved for Eurocode 2-2004 concrete frame shear design where the shear 
capacity Vrdc could be incorrect when the model database units were not in N-mm. Note that 
the database units are those in effect when the model is created or imported, regardless of 
the current units used for display. 

  2884 An incident was resolved where the pier and spandrel shear capacity for CSA A23.3-14 code 
could be incorrect because the Epsx value was using the rebar ratio instead of the rebar area. 
Shear design reporting has been enhanced to report the values of Ast, Epsx, beta and theta 
values for pier and spandrel design. Boundary zone reporting has also been enhanced. 

Design – Composite Beam 
Incidents Resolved 

* Ticket # Description 
  2820 An incident was resolved that affected the composite design of beams whose Vibration 

Criterion was set to Rhythmic in their composite beam design overwrites. Such beams were 
not being designed but instead displayed a generic error message. This error did not occur 
when the Vibration Criterion was set to Rhythmic in the design preferences, only when using 
the design overwrites. This issue affected ETABS versions 17.0.0 to 18.0.2.  

  2855 An incident was resolved which affected the composite design of beams supported by girder 
beams whose own design method was set to None. Unless the Vibration Criterion was set to 
None in the composite beam design preferences or in the composite beam design overwrites 
of the composite beams framing into the girder beams, such composite beams could not be 
designed but instead displayed a generic error message. This issue affected ETABS versions 
17.0.0 to 18.0.2. 

  3189 An incident that affected composite beam design per the various CSA design codes has been 
resolved. When designing composite beams per any of the CSA design codes and evaluating 
the deflections caused by concrete shrinkage, shrinkage-specific composite section properties 
were not being computed, but instead the regular composite section properties were being 
used. Because the shrinkage-specific composite section properties are computed based on a 
reduced age-adjusted modulus of elasticity for concrete, the design underestimated the 
deflections caused by concrete shrinkage. The strength of the beams was not affected, and 
the effect on their serviceability was minor. All previous versions of ETABS that designed 
composite beams per the various CSA design codes were affected. 

  3376 An incident was resolved which affected the design of composite beams with a cover plate per 
either of the AISC 360-16, CSA S16-14, or Eurocode 4-2004 codes. These codes include a 
bottom flange stress check and ETABS would not produce any design for beams with a cover 
plate because it mistakenly evaluated their bottom flange stress as infinity. This could be 
observed when attempting to design the beam interactively. This incident affected all versions 
of ETABS greater than v17.0 and when it occurred, no designs were produced for these 
beams. The bottom flange stress is now properly evaluated for beams with a cover plate. 
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* Ticket # Description 
 3396 An incident was resolved which affected the composite beam design of girders loaded by 

beams when the selected design code was BS5950-1990, CSA S16-14 or Eurocode 4-2004 and 
the model database units were US customary units. If the point loads applied by the various 
beams supported by the girder differed from one another, the equivalent line load on the 
girder was incorrectly reported in the vibration check girder output – and could even be 
reported as negative. This was a reporting error only and the reported equivalent line load 
was not being used when computing the girder deflection. The strength and serviceability of 
the designed girders were unaffected. The equivalent line load is now reported correctly.  

Design – Slab 
Incidents Resolved 

* Ticket # Description 
  2870 An incident was resolved where the Slab PT stresses used for the stress check under service 

loads could be incorrect in versions 17.0.0 to 18.0.2. The stresses could be calculated at the 
wrong point, and when incorrect they were reported too high. This affected the reported 
demand-capacity ratio. Strength design and analysis results were not affected. The 
corresponding verification examples have been changed to reflect values reported in the 
"Concrete Slab Design" tables rather than the analysis tables. The change was insignificant for 
the purposes of these verification examples. 

  2871 An incident was resolved where slab-strip integrated moments were not accounting for any 
slab vertical offsets specified if prestressing tendons were not present in the model. No 
analysis results were affected, and this was only a post-processing issue. This affected versions 
17.0.0 to 18.0.2. 

* 3259 An incident was resolved where the slab strip design for one-way shear could have been 
incorrect for single-valued combinations. This error did not affect flexural design or punching 
shear checks. This error affected ETABS versions 18.0.0 to 18.0.2. 

Results Display and Output 
Incidents Resolved 

* Ticket # Description 
  2574 An incident was resolved where animations generated using the command File > Create Video 

> Multi-step Animation were always plotting relative displacements even when the option 
Absolute Displacements was selected. By way of background, absolute displacements include 
the ground displacements when acceleration loads are applied, whereas relative 
displacements do not. No other results were affected. 

  2635 An incident was resolved where the load pattern, load case, and load combination filters for 
reports were not being applied. Instead, the latest selections made for displaying tables were 
being used. Now the selections made in the report options are kept separately from those 
used for displayed tables. This was a reporting issue only and did not affect results. 

  2733 An incident was resolved where design results for wall-pier boundary zone checks were not 
available in reports. They were available when looking at individual wall-pier detailed design 
results on-screen. This was a reporting omission. No results were affected. 

  2789 An incident was resolved for the steel frame design code "Chinese 2018" where the calculated 
K factors were not exactly correct for a column connected to a beam that had a moment hinge 
at the far end or to a column above or below that had a moment hinge at the far end. Both 
sway and non-sway moment frames were affected. Similarly, the K factors were affected for 
the sway frames of all other codes for the columns connected to beams or columns (above or 
below) that had moment hinges at their far ends. The error was small and the effect on design 
results was generally insignificant. 
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* Ticket # Description 
* 2949 An incident was resolved where, for nonlinear static, staged-construction, direct-integration 

load cases, and sequences of such load cases, the frame member forces and stresses used for 
display and design could have been incorrect for a specific frame member when the following 
conditions are met:  
(1.) The load case (or sequence of load cases) contained more than one load pattern that 
applies loads directly to the frame member, including at least one load pattern with self-
weight loads.  
(2.) A load pattern containing self-weight load (A) was applied after another load pattern 
containing frame loads (B); in other words, A was listed after B in the list of applied loads in 
the load case definition (or sequence).  
(3.) The load patterns A and B had different scale factors.  
Frame members that did not meet the above conditions, such as those without frame loads 
assigned to the load patterns used in the load case sequence, were not affected. Load case 
sequences without self-weight applied were not affected. Load case sequences having only 
one self-weight load pattern applied and with that load pattern being listed first in the load 
case definition were not affected. Note that this error did not affect how the frame loads were 
transferred to the structure, and therefore all other analysis results were correct 
(displacements, reactions, forces and stresses in other objects). Nonlinear behavior, including 
frame hinges and P-delta, was not affected. Only the reported forces and stresses within the 
affected frame members themselves were in error, including the forces used for frame design 
of those members. Because self-weight is most commonly applied first, most models were not 
affected by this error. Linear load cases were not affected, even if they used the stiffness from 
a nonlinear load case. This error affected ETABS versions 17.0.0 to 18.0.2. 

* 3045 An incident was resolved where, for nonlinear static, staged-construction, direct-integration 
load cases, the frame member forces and stresses used for display and design could have been 
incorrect for a specific frame member when the following conditions were met:  
(1.) Results were requested for multiple load cases at the same time, including situations 
where one or more requested load combinations referenced multiple load cases.  
(2.) Among all the requested load cases, only one of these was a nonlinear static, staged-
construction, or direct-integration time-history load case, and only a single step was requested 
from that load case.  
(3.) Among all the requested load cases, at least two of these were linear load cases (including 
modal or response-spectrum), at least two of these load cases used the stiffnesses from 
different nonlinear load cases (or zero initial conditions), and at least one of these was a linear 
static, linear multi-step static, or modal time-history load case.  
(4.) The affected frame object had loads assigned to it as part of the single nonlinear load 
case. This could include self-weight. 
This was not common. When this error occurred, the frame response reported in the affected 
object could be incorrect at all stations along the length of the object except at the start (I 
end). For frame objects that were discretized into multiple elements for analysis, the results 
would be correct at the start of each element and deviate along the length of the individual 
elements. This deviation in response, when present, was due to using the wrong element load 
for equilibrium calculations. This error would be most likely to affect table results when 
multiple load cases or load combinations were requested, and frame design when the load 
combinations used satisfy the conditions listed above. Note that this error did not affect how 
the frame loads were applied to the structure, and therefore all other analysis results were 
correct (displacements, reactions, forces and stresses in other objects). 

  3081 An incident was resolved where refreshing plot functions or quick hysteresis plots after 
unlocking and re-running the analysis could generate an error or lead to unexpected 
termination of the software. The results were not affected. 
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* Ticket # Description 
* 3084 An incident was resolved where tabulated analysis results may have been displayed as zero for 

load combinations that contained one or more multi-step load combinations. A load 
combination can be multi-step if the load combination is of type Linear Add and the load 
combination contains a multi-step nonlinear static or time-history load case or another multi-
step load combination. When this issue occurred, the tabulated results for a Linear Add type 
load combination that contained a multi-step load combination could have been displayed as 
zero. This issue only occurred when the following conditions were met: 
(1.) The model included multiple load combinations that each contained the same multi-step 
Linear Add type load combination (say "A") in its definition. 
(2.) In the Choose Tables for Display form (Display menu > Show Tables), more than one of the 
containing load combinations were selected for output. 
(3.) At least one of the selected load combinations containing combination "A" must have 
been of type Linear Add, and at least one must have been of a different type (e.g. Envelope). 
(4.) In the Database Table Output Options form (Modify/Show Options button in the Choose 
Tables for Display form), "Multiple Values, If Possible" was selected for Load Combination 
Results. 
Any load combination containing affected load combinations could also be affected. This issue 
only affected the tables under the Analysis Results section. This issue did not affect visually 
displayed results or design results. This issue did not affect load combinations that were not 
nested. This issue was only present in ETABS versions 18.0.0 to 18.0.2. 

  3200 An incident was resolved where the strip design details report was only showing text values 
for the top longitudinal rebar, omitting the bottom values, on the longitudinal rebar diagram. 
This was a reporting issue only and did not affect results. 

  3223 An incident was resolved where, for a certain model, a load combination that included 
response spectrum loads was only displaying the maximum results instead of both the 
maximum and minimum results in the on-screen display and in database tables. This was not 
common. 

  3377 An incident was resolved that corrected two issues with pushover analysis: 
(1.) The monitored displacement shown using the command Display > Static Pushover Curve 
was always zero for nonlinear static load cases where the load application control was set to 
"Full Load".  
(2.) For nonlinear static load cases where the load application control was set to "Quasi-Static 
(run as time history)" and the monitored displacement was a generalized displacement, only 
the first item in the generalized displacement definition was being used as the monitored 
displacement.  
Neither of these issues affected displacement-controlled nonlinear static load cases, which are 
the type most commonly used for pushover analysis.  

User Interface 
Incidents Resolved 

* Ticket # Description 
  1414 An incident was resolved where columns cross-sections were not shown in Plan views when 

the shading option was selected using command Options > Graphics Preference for Standard 
Graphics. This was just a display issue and no results were affected. 

  2083 An incident was resolved where link objects were always present in the view even if they fell 
outside the specified X and Y limits set using command View > Set Building View Limits. 
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* Ticket # Description 
  2394 An incident was resolved where the Wall Hinge Reinforcement assignment form did not 

behave correctly when used following the import of the model text file (.E2K, .$ET). For 
example, the bar size and number of bars could not be changed, the stations in the 
Reinforcement section were all reported as “Start”, and program-computed “Number of Bars” 
values were incorrect. Results were not affected if the OK button was not clicked after viewing 
the form. Opening the model from the .EDB file did not have this issue. 

  2505 An incident was resolved where items in the Tools menu disappeared when changing to an 
alternate language. 

  2578 An incident was resolved where wall stacks were not being drawn for just the selected stories 
but were instead being drawn for all stories in a single tower. 

  2838 An incident was resolved related to editing the definition of section-cut quadrilaterals when 
more than one quadrilateral was defined. When using arrow buttons to move between the 
definitions for the different quadrilaterals, the coordinates of the quadrilateral being edited 
may have been copied from a different quadrilateral. Section-cut results were consistent with 
the quadrilaterals as ultimately defined. No other results were affected. 

  2970 An Incident was resolved where the boundary zone lengths could not be specified for the wall 
hinge reinforcement assignment when Chinese language was chosen for the user interface. 

Drafting and Editing 
Incidents Resolved 

* Ticket # Description 
  2497 An incident was resolved where, when the graphics mode was set to "Standard Graphics", 

drawing a line strain gauge and ending it with a right click could cause an additional line gauge 
to be added that connected to a random point. No results were affected. 

Graphics 
Incidents Resolved 

* Ticket # Description 
  2084 An incident was resolved where a drawn link object was not visible in the model window when 

a link was added if the link visibility was turned off in that view using command View > Set 
Display Options. This issue then prevented the newly drawn link from being displayed later in 
that view even after link visibility was turned back on. Only using the command View > Show 
All Objects would restore visibility. 

  2495 An incident was resolved that addressed two issues with DirectX graphics mode: 
(1.) Switching between plan-view levels using the "Move Up" or "Move Down" buttons could 
cause the dimension lines to disappear. 
(2.) The model sometimes disappeared when displaying the deformed shape in a plan view. 
These issues were graphical only, and no results were affected. 

  2504 An incident was resolved where point springs were not visible at point objects that were not 
associated with any tower. This issue did not affect models that never enabled the multi-
tower option. This was a display issue only. No results were affected.  

  2585 An incident was resolved where Greek and Cyrillic symbols (obtained by using the Alt+### key 
combination) were not shown using the DirectX graphics option. The basic alphabetic 
characters have been added in the range 913 to 969 (Hex 391 to 3C9) and 1040 to 1103 (Hex 
410 to 44F), respectively. 

  2595 An incident was resolved where the menu command View > Show Rendered View was 
inadvertently available in the user interface. This command has now been removed since 
DirectX graphics mode provides better rendered views directly in the model windows.  
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* Ticket # Description 
  2636 An incident was resolved for DirectX graphics where the right-click display of contour plots of 

forces, moments, or stresses for an individual area object were sometimes upside down with 
respect to the contour plots of the same object in the model window. This was a display issue 
only and no results were affected. 

  2683 An incident was resolved where diaphragm forces (command Display > Force/Stress Diagrams 
> Diaphragm Forces) were not shown in DirectX graphics mode. This display worked correctly 
in Standard Graphics mode. 

  3044 An incident was resolved where the command Draw > Draw Section Cut was not working for 
DirectX graphics. Standard Graphics mode was not affected. 

Data Files 
Incidents Resolved 

* Ticket # Description 
  2880 An incident was resolved where opening a very large model file could take a much longer time 

than in v17. The issue was caused by additional checking for duplicated points, which was 
introduced in v18. This check has now been made more efficient. 

Database Tables 
Incidents Resolved 

* Ticket # Description 
  2583 An incident was resolved where results for section cuts and generalized displacements would 

not show up in the output tables if their definitions had been imported from database tables 
or created using the interactive database editor. This issue was resolved for previously 
released ETABS v18.0.2 but was inadvertently omitted from the Release Notes. 

  2747 An incident was resolved where a fatal import error was reported when importing certain 
database tables if there were no records in the table. This has been changed to a warning so 
that the import can continue. 

  2793 An incident was resolved where the item "Floor Area" in the "Material List by Story" table had 
units of length instead of length^2 (area). When the table was displayed in units different 
from the database units, the values shown were incorrect. Note that database units are those 
used internally, and these are set when the model is first created or imported.  

  3027 An incident has been resolved where frame section properties specified as "From File" = "Yes" 
may be deleted upon import if the specified property file was not found or if the specified 
section property was not found in the property file. Now the frame section and its saved 
section-property values are imported, even if the original file source is not available. 

  3091 An incident was resolved where importing more than 20 rows in the Pier Label Definitions or 
Spandrel Label Definitions tables resulted in an error. This also affected Interactive Database 
Editing. No results were affected, but the tables could not be fully imported when this 
occurred. 

  3137 An incident was resolved that addressed three issues with the frame section property files 
(XML): 
(1.) The EDI labels were incorrect for some sections in the frame section property files for the 
AISC14, AISC14M, AISC15, AISC15M, Australia-NewZealand, CISC9, CISC10, Euro and Nordic 
section database. This label is used by ETABS to determine the shape types to be used for 
steel frame design. This issue affected ETABS versions 18.0.0 to 18.0.2. 
(2.) Missing auto select lists were added to the AISC14 and AISC15 property files. 
(3.) As an enhancement, a new section property file was added for Korean frame sections. 
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* Ticket # Description 
  3241 An incident was resolved where the table of auto-seismic load pattern definitions was showing 

certain spurious values in the records for the defined seismic load with multiple directions of 
loading. These values (period used, weight used, base shear) were meaningless for multiple 
directions of loading and have been removed. The records for the individual loading directions 
did, and still do, show these values correctly. 

Application Programming Interface (API) 
Incidents Resolved 

* Ticket # Description 
  2541 An incident was resolved for the import of P, V2, V3, T, M2 and M3 hinge definition tables 

where fields with the field keys SSPOSFORSF and SSNEGFORSF were not fully implemented 
and could in some cases lead to import errors being reported. This issue was resolved for 
previously released ETABS v18.0.2 but was inadvertently omitted from the Release Notes. 

* 2843 An incident was resolved for the Application Programming Interface (API) where a load 
combination created using the methods in cCombo sometimes did not display the correct 
envelope results. This issue did not affect load combinations that were created using the 
graphical user interface (Define > Load Combinations) or through Interactive Database Editing 
(Edit > Interactive Database). This issue only affected load combinations created in versions 
18.0.0 to 18.0.2 using the API. 

 

External Import and Export 
Incidents Resolved 

* Ticket # Description 
  2917 An incident was resolved where the Story Drift and Story Forces tables might not export 

correctly to Excel from the File menu. When this occurred, the exported tables were blank or 
incomplete. This behavior was intermittent and was due to parallelization of the export of 
these tables. No results were affected. 

Documentation 
Incidents Resolved 

* Ticket # Description 
  2643 An incident was resolved where the items listed on the Index tab of the context sensitive help 

(F1) were truncated by one character. This was only an issue in the help and had no impact on 
the functionality of ETABS. 

  2866 An incident was resolved to correct one minor typographical error each in Table 3-1 for Singly 
Symmetric I-Shaped sections (Flexure in Web) and Table 3-2 for Doubly Symmetric I-Shaped 
sections (Axial only compression in flanges of built-up I-Shapes) of the AISC 360-10 and AISC 
360-16 Steel Frame Design manuals. These were documentation errors only and no results 
were affected.  

  3175 An incident was resolved where Equation 4-7 of the Material Time-Dependent Properties 
Technical Notes was incorrect. The equation has been corrected in the documentation. This 
was a documentation issue and did not affect the results.  
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